Zip Manager Help Index

This file contains the complete documentation for Zip Manager. Please read it carefully to be sure that you
correctly install Zip Manager. Use the scroll bars, PgDn, PgUp, or the arrow keys to display help topics
not currently visible.

If you are not familiar with the Windows help system, press F1 or choose Using Help from the Help menu.
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Introduction

Zip Manager is a Microsoft Windows 3.0 program that allows you to work with files in the Zip format
created by PKWARE'S PKZIP and PKUNZIP file compression utilities.

To use Zip Manager you must have PKZIP.EXE and PKUNZIP.EXE. Be sure to use version 1.10 or later
of PKZIP and PKUNZIP. Please refer to the installation instructions on how to obtain these programs.

Portions of this documentation are Copyright 1990 by PKWARE Inc., and reproduced here with the
permission of PKWARE Inc. PKZIP and PKUNZIP are trademarks of PKWARE Inc.



Installation And Setup

To install Zip Manager copy the following files to your Windows directory. All of these files MUST be
present in order for Zip Manager to function properly.

1.) ZM.EXE (The Windows Executable)

2.) ZM1.EXE (The Zip File Interpreter for ZM.EXE)
3.) PKZIP.PIF (Windows PIF For PKZIP)

4.) PKUNZIP.PIF (Windows PIF For PKUNZIP)

5.) ZM.HLP (This File)

MAKE SURE that both your Windows directory and the directory where PKUNZIP and PKZIP reside are
in the path statement of your autoexec.bat file, as in the example below:

path=c:\;c:\bin\;c:\utility\;c:\dos\;c:\windows;

Although the drive letters and directory names may differ. As long as Windows and the directory
containing PKZIP and PKUNZIP are in your path, Zip Manager will function correctly.

The PIF Files:

DO NOT MODIFY the PIF files PKZIP.PIF, PKUNZIP.PIF, and ZM1.PIF. Zip Manager's code will
determine what mode windows is currently using and pass the correct parameters to the appropriate PIF
file. UNDER NO CIRCUMSTANCES should you specify a startup directory in any of these PIF files.
Zip Manager will find and execute the needed programs since it has access to the path.

You must have PKZIP and PKUNZIP Version 1.10 or later. These files are in PKZ110.EXE available in the
MSWIN forum on Compuserve and on most BBS systems across the country. You should register to get
the most current version from:

PKWARE Inc. 7545 North Port Washington Road, Suite 205

Glendale, WI 53217

Voice(414) 352-3670

BBS (414) 352-7176

Complete ordering information is contained in PKZ110.EXE



License Agreement

No part of this manual may be reproduced in any form or by any means, except as described in the
following license agreement or without the express prior written consent of Moon Valley Software Inc. The
use of Zip Manager is subject to the following terms and conditions.

Title To The Licensed Software

Title to the licensed software is NOT transferred to the end user. The end user is granted an exclusive
license to use the software on a SINGLE computer or computer work station. EACH computer or
computer work station must have its own licensed copy of the software.

Copyright Protection

Zip Manager is copyrighted material. It is protected by the copyright laws of the United States, the State of
Arizona, and other proprietary rights of Moon Valley Software Inc. You may not make any changes or
modifications to Zip Manager or this manual. You may not decompile, disassemble, or otherwise reverse-
engineer the software in any way.

You may make copies of Zip Manager only under the terms of the section entitled "Limited License To
Copy The Licensed Software". You may use Zip Manager on a trial basis provided you do not violate the
protection afforded the licensed software by the copyright laws, and you agree to the terms of the license
agreement. If you use Zip Manager on a regular basis you are required to purchase it.

Limited License To Copy The Software

You are granted a limited license to copy Zip Manager ONLY FOR THE TRIAL USE OF OTHERS subject
to the terms of this software license agreement and the conditions described below:

-> Zip Manager MUST be copied in an unmodified form and MUST contain the following files:
ZM.EXE
ZM1.EXE
ZM.HLP
PKZIP.PIF
PKUNZIP.PIF
README.1ST
REGISTER.FRM

-> No fee, charge or other compensation may be charged or accepted or requested by anyone to
access the Zip Manager files without the express written permission of Moon Valley Software. THIS
INCLUDES ALL DISK VENDORS, if they charge any fee other than for the disk the program files a
distributed on.

-> Operators of electronic bulletin board systems (Sysops) may post Zip Manager for downloading by
their users without written permission ONLY AS LONG AS THE ABOVE CONDITIONS ARE MET. A fee
may be charged for access to the BBS AS LONG AS NO SPECIFIC FEE IS CHARGED FOR
DOWNLOADING Zip Manager files without first obtaining express written permission from Moon Valley
Software to charge such a fee.

-> Distributors of public domain and user supported software, such as disk vending services, may
distribute copies of Zip Manager subject to the above conditions

Limited Warranty

Moon Valley Software does not warrant that the licensed software will meet your requirements or that the



operation of the software will be uninterrupted or error free. The warranty does not cover any media or
documentation which has been subjected to damage or abuse by you or others. The software warranty
does not cover any copy of the licensed software which has been altered or changed in any way.

ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE ARE LIMITED TO THE TERM OF THE EXPRESS WARRANTIES.
Some States do not allow limitations on how long an implied warranty lasts, so the above limitation may
not apply to you.

Other Warranties

The warranties set forth above are in lieu of any and all other express or implied warranties, whether oral,
written, or implied, and the remedies set forth above are the sole and exclusive remedies.

Limitation Of Liability

Moon Valley Software is not responsible for any problems or damage caused by the licensed software
that may result from using the licensed software. This includes, but is not limited to, computer hardware,
computer software, operating systems, and any computer or computing accessories. End user agrees to
hold Moon Valley Software Inc. harmless for any problems arising from the use of the software.Moon
Valley Software SHALL NOT IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM ANY BREACH OF
THESE WARRANTIES EVEN IF Moon Valley Software OR ITS AGENTS OR DISTRIBUTORS HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some states do not allow the exclusion or
limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to
you.In no case shall Moon Valley Software's liability exceed the license fees paid for the right to use the
licensed software, or a sum no greater than one Dollar ($1.00), whichever is less.

The above constitutes the license agreement for Zip Manager. It supersedes any and all previous license
agreements.



Add / Create

When you choose Add / Create from the File Menu, a dialog box is displayed allowing you to select a Zip
file, or enter the name of a Zip file you wish to create.

Once you have made your choice and clicked on OK, a second dialog box displays the available files in
the current directory. Mark the files you wish to add by clicking on them with your mouse.

When done marking the files click on OK and the Zip file will be created. Add / Create uses the -a PKZIP
option.



Move
When you choose Move from the File Menu, a dialog box is displayed allowing you to select a Zip file, or

enter the name of a new Zip file.

Once you have made your choice and clicked on OK, a second dialog box displays the available files in
the current directory. Mark the files you wish to move into the Zip file by clicking on them with your mouse.

When done marking the files click on OK. First PKZIP will create the Zip if it doesn't exist. Then the
selected files will be moved into the Zip. Move uses the -m PKZIP option.




Update

When you choose Update from the File Menu, a dialog box is displayed allowing you to select available
Zip files.

Once you have made your choice and clicked on OK, a second dialog box displays the available files in
the current directory. Mark the files you wish to have PKZIP update.

When done marking the files click on OK and the files will be updated. Update uses the -u PKZIP option.



Freshen

When you choose Freshen from the File Menu Zip Manager updates files that exist in the ZIP file with
same-named files that have more current time and date stamps.

In 386 Enhanced mode the freshen option will not display any results in the window UNLESS AN ERROR
OCCURRED. If you run freshen and it appears that nothing happened, rest assured that the operation
was successful.

The Freshen option is limited to working with files that exist in the Zip file. Existing files will be overwritten
ONLY if the files have been updated since being added to the Zip. It will NOT add new files. Freshen uses

the -f PKZIP option.



Delete

When you choose Delete from the File Menu, a dialog box is displayed allowing you to select available
Zip files to delete. Delete improves on the standard PKZIP delete command by allowing you to delete an
entire Zip file without exiting Windows.

Once you have made your choice and clicked on OK, a second dialog box will ask if you would like to
delete the entire Zip file or selected files contained in the Zip.

If you choose selected files a dialog box listing the files in the Zip is displayed. Mark the files you wish to
delete.

When done marking the files click on OK and the files will be deleted from the Zip. Delete uses the -d
PKZIP option.

CAUTION! Selecting the entire Zip for deletion will DELETE it completely. Please be sure you want to
delete the entire file.



Test

Select Test from the Utilities Menu. This option tests the Zip file selected to be sure it is valid and has not
become corrupt. This option does not extract files from the Zip, it only tests them.

The results of your last Zip test will remain displayed in the window until you select another file operation.
If you are testing more than one Zip file and are interrupted you can return to your work and know the last
file you tested.



Encrypt
The Encrypt option is an on - off switch.

When the menu item is checked(on) each time you perform any action involving a Zip file, Zip Manager
will prompt you for a password. If you normally encrypt every file this will save you the extra step of
setting encrypt each time. If you don't normally encrypt files simply click encrypt again to turn it off.

Use a password that you can remember easily and record it in a safe place. Failure to record your
password could result in not being able to extract a file later. The passwords ARE CASE SENSITIVE.
Please remember this when recording your password. Encrypt uses the -s PKZIP option.




Registration

Zip Manager is distributed as Shareware. If you use it you are obligated to register it. By registering you
will receive the latest version of the program, and won't be bothered by the registration box that appears
each time the program is started. Upon registration we will ship you the most current version, or you can
download it from our private BBS.

The registration fee is $20.00 plus $1.50 shipping and handling. Please use the enclosed registration
form. You can register by phone using Master Card Or Visa. Phone orders are taken 9:00am - 4:00pm
Monday - Friday MST. Call Moon Valley Software at (602)375-9502



Technical Support

As a registered user of Zip Manager you will receive the number to our private BBS and complete voice
tech support. In addition you will receive advance notice of all major upgrades and receive interim
updates if necessary at no charge.



Short Zip File Listing

The Short Listing contains the basic information about each file contained in the Zip. The results of your
last file listing request will remain displayed in the window until you select another file operation. Below is
an example of the Short Listing Option:

PKUNZIP (R) FAST! Extract Utility Version 1.1 03-15-90 Copr. 1989-1990 PKWARE Inc. All Rights
Reserved. PKUNZIP/h for help PKUNZIP Reg. U.S. Pat. and Tm. Off.

Searching ZIP: TEST1.ZIP
Length Method Size Ratio Date Time Name

1285 Implode 656 49%  07-16-90 10:14 SAMPLE1.EXE

4441  Implode994 78%  07-13-90 11:28 SAMPLE1.BAK
4460 Implode929 80%  07-17-90 10:16  SAMPLE2.EXE
9171  Implode625 32% 07-17-90 10:22 SAMPLES.EXE
4660 Implode108 77%  07-17-90 09:03 SAMPLE4.TXT
5170 Implode 186 64%  07-17-90 10:22 SAMPLES.EXE
1042 Implode378 64% 07-17-90 09:03 SAMPLEG.EXE

213668 73244 66% 8



Verbose Zip File Listing

The Verbose File listing contains more technical information such as CRC checking, File Attributes, etc...
Otherwise it is the same as the Short Listing.



Extract

Select Extract from the Main Menu Bar. You are presented with a dialog box containing the following
options.

EXTRACT:

1.) All files.

2.) Selected Files.

3.) To A Sub Dir. Please Read The Special Notation Listed Below.

Option 1 will extract all of the files in the selected Zip.

Option 2 displays a dialog box listing the files in the Zip. Select the file(s) you wish to extract. When you
have finished marking files for extraction click on OK to begin extraction.

Option 3 will extract the files marked to the drive and directory you specify using the available drives and
directories list box.

Option 3 Important Note: If you wish to extract files to a different sub directory DO NOT enter the
directory name in the edit line of the dialog box. Instead select a target drive/directory by clicking
on it with your mouse in the drive/directory list box. This offers protection from accidently
entering an incorrect drive, directory, or path name.



PKZIP Command Line Reference
The following table lists all the options valid with the PKZIP command.
-a Adds files to ZIP file.

-b [path] Creates a temporary ZIP file at the specified alternate location. This temporary file is used only in
the creation of the ZIP file, and will be automatically deleted when the process is complete.

-c -C Adds file comments to individual files within the ZIP file.

-d Deletes the specified files from the ZIP file.

-e [x,s,a,b] Specifies compression method.

-f Freshens files in the ZIP file.

-h Calls up a help screen.

-i Adds to the ZIP file only those files that were changed since the ZIP file was last updated.
-j -J<h,r,s> Specifies masking or unmasking of file attributes.

-k Retains the original date of the ZIP file that is being updated.

-l Displays the license screen.

-m [u,f] Adds files to the ZIP file and automatically deletes the original or source files.

-0 Sets time and date of the ZIP file to the time and date of the latest file contained in the ZIP file.

-p -P Stores paths that are recursed along with the filenames in the ZIP file. The -p option should be used
with -r option.

-q Enables ANSI comments.

-r Recurses subdirectories from the specified directories.

-s <password> Scrambiles files in the ZIP file with password protection.

-u Updates the ZIP file.

-v [b,r,t,c,d,e,n,0,p,s] Views technical information about files in the ZIP file.

-w -W<h,s> Specifies whether hidden or system files will be included in the ZIP file.
-x |s used to exclude files from a ZIP file operation.

-z Creates a ZIP comment for a ZIP file.

Note: Parameters listed in [ ] are optional. Where parameters are listed in < >, at least one of the
listed parameters must be specified.



PKUNZIP Command Line Reference

The following table will provide a quick reference guide to all of the options of PKUNZIP. The command
syntax is also shown below.

PKUNZIP [options] zipfile [d:path\] [file...] zipfile = ZIP file name. Default extension is .ZIP file = Names of
files to compress. Wildcards *, ? are ok. Default is ALL files. list = An optional list file name.
Options are:

-c [m] = Extract files to the screen [with more]

-d = Create directories on extraction from ZIP file

-h = Call up help screen

-j -J<h,r,s> = Mask/Unmask file attributes

-1 = Display license information

-n = Extract only newer files

-0 = Overwrite existing files

-p [a/b][c][n] = Extract files to the printer

-s <password> = Unscrambles files with password protection

-t = Test ZIP file integrity

-q = Enable ANSI comments

-v [b,r,c,d,e,n,p,s] = View file information

-x = Extract files (the default option)



PKZIP Error Messages

The following error messages may appear when using PKZIP.
When the word "WARNING' appears in the message, program
execution will continue, otherwise, the program will abort to DOS.

A brief explanation of each message follows.
PKZIP: Can't open XXXX.ZIP for write access!

The named ZIP file is read-only or locked by another application and can not be modified.
PKZIP:No file(s) found. No matching files were found to list using the View option.

PKZIP: Insufficient disk space for updated files:XXXX.ZIP.The -b option was used, and there is not
enough space on the original drive containing the ZIP file to receive the updated ZIP file. Try to free up
some space on the drive containing the ZIP file, and retry the operation. Also, make sure that the drive
specified with the -b option is different than the drive containing the ZIP file.

PKZIP: Insufficient disk space for ZIP comment.
There is insufficient disk space to hold the comment as entered.

PKZIP: Warning! Not enough memory for Shrinking method. The -es or -ea or -eb options were used to
specify that certain files should be Shrunk. However, there is not enough memory available to perform
Shrinking. Instead, all files will be Imploded.

PKZIP: Warning! Can't delete XXXXX. The -m (Move) option was specified to delete files after the ZIP
file was constructed. However, the named file could not be deleted, and is probably read-only.

PKZIP: No files specified for deletion! The -d (Delete) option was specified, but no flenames were given
to delete.This option does NOT default to *.* if no filenames are given.

PKZIP: Nothing to do! No matching files, or files with the specified attributes, or files after the specified
date etc., were found to compress.

PKZIP: Insufficient memory.Insufficient memory is available to process the ZIP file. Try making more
memory available to PKZIP. If this does not rectify the problem, then the ZIP file might be corrupted, and
PKZIPFIX should be used to fix the ZIP file.

PKZIP: XXXX.ZIP - error in ZIP, use PKZIPFIX. The named ZIP file has a corrupted file index. Use
PKZIPFIX to reconstruct the ZIP file.

PKZIP: Can't create: XXXX. The named file could not be created.Either the target directory is full or the
file already exists and is read-only or locked by another application.

PKZIP: Disk full, file: XXXX. A disk full error occurred while writing to the specified file. Try freeing up
some disk space on the target drive. Also, see the -b option and the PKTMP environment variable.

PKZIP: Can't find: XXXX.ZIP. The named ZIP file could not be found.

PKZIP: Too many files. There are too many files to compress into one ZIP file. The limit is 3900 files per
ZIP file.



PKUNZIP Error Messages

The following error messages may appear when using PKUNZIP.A brief explanation of each message
follows.

PKUNZIP: Warning! File XYZZY already exists. Overwrite (y/n)? The file XYZZY already exists on the
disk. Pressing N will leave the original file on the disk, and not extract

the file from the ZIP file. Pressing Y will extract the file from the ZIP file, and overwrite the file on the
disk. Also, see the -0 and -n options.

PKUNZIP: Warning! | don't know how to handle: XYZZY. The file XYZZY is compressed or encoded in a
way that this version of PKUNZIP is unable to handle. Either a
later version of PKUNZIP is required to properly extract this file, or the ZIP file is possibly corrupted.

PKUNZIP: Warning! Inconsistent local header for file: XYZZY.

The local header for file XYZZY is different than the central header information. Use PKZIPFIX to
reconstruct the ZIP file.

PKUNZIP: Warning! File fails CRC check. The CRC-32 check for the file being extracted or tested did not
match the stored value for the file. The file is probably corrupted.

PKUNZIP: Warning! XXXX.ZIP has errors. The named ZIP file had one or more errors detected in it.

PKUNZIP:Warning! File has bad table. The file being tested or extracted has an error in its encoding. The
file is probably corrupt.

PKUNZIP: Warning! No file(s) found. No files were found to extract, test, or list.

PKUNZIP: Warning! XXX.ZIP - error in ZIP, use PKZIPFIX. The named ZIP file has a corrupted file index.
Use PKZIPFIX to reconstruct the ZIP file.

PKUNZIP: Warning! Insufficient memory Insufficient memory is available to process the ZIP file. Try
making more memory available to PKUNZIP. If this does not rectify the problem, then the ZIP file might be
corrupted, and PKZIPFIX should be used to fix the ZIP file.

PKUNZIP: Warning! Can't create: XXXXX. The named file could not be created. The output directory is
either invalid or full.

PKUNZIP: Can't find: XXXX.ZIP. The named ZIP file(s) could not be found.
PKUNZIP:Can't open: XXXX The specified file list could not be opened.

PKUNZIP:Warning! Can't open XXXX.ZIP The named file could not be opened. Either a disk error
occurred, or the file is locked by another application.

PKUNZIP: Disk full, file: XXXXX. There is not enough free room on the destination drive/directory for the
file being extracted. The program will abort and exit to DOS.

PKUNZIP: Incorrect password for file. The ZIP file is password protected, and cannot be opened unless
the correct password is entered. The password entered is not the correct password.

PKUNZIP: Skipping encrypted file. Only the files that are password will be skipped (not extracted)
because they are password protected and the correct password was not entered.






Using Zip Manager With 80486/386/286/88 CPU'S

Zip Manager has been carefully tested to operate successfully with all of the above computers. It has
been specifically designed to exploit the maximum from each CPU.

Automatic CPU/Windows Mode Detection

Zip Manager automatically detects the present CPU available and/or the current Windows operating
mode.

386/486 Enhanced Mode

If a 386/486 CPU is detected Zip Manager will multi-task PKZIP and PKUNZIP as a background task. In
fact the only evidence you may have that a program event has occured is a brief display of the Windows
DOS icon flashing briefly at the bottom of the Windows desktop.

286/88 Standard And Real Mode Operation

Under Standard Mode(286 Protected) and Real Mode(8088) Zip Manager is forced to run PKZIP and
PKUNZIP as a foreground task. User's of these computers still benefit from all of Zip Managers other
features. PKZIP and PKUNZIP are only run momentarily as a foreground task before returning you to
Windows.



Zip Manager PIF Files

The PIF files supplied with Zip Manager have already been configured for proper operation in all three
Windows operating modes, and for 386/286/8088 CPU'S as well.

DO NOT MODIFY the PIF files PKZIP.PIF, PKUNZIP.PIF, and ZM1.PIF. Zip Manager's code will
determine what mode windows is currently using and pass the correct parameters to the appropriate PIF
file. UNDER NO CIRCUMSTANCES should you specify a startup directory in any of these PIF files.
Zip Manager will find and execute the needed programs since it has access to the path. If you feel you
must modify them please make a backup copy before doing so.






The -a Option

The -a option adds files to an existing Zip file. If the specified Zip file doesn't exist PKZIP creates it. Using
the -a option will place the selected files in the Zip and leave the original files on your drive. This is a very
good option to use if you want to perform data file backup to a Zip file.



The -m Option

The -m option moves files to an existing or new Zip file. If the specified Zip file doesn't exist PKZIP
creates it. Using the -m option will place the selected files in the Zip. It will NOT LEAVE your original files
available. All of the selected files will be moved into the Zip file. This is very useful if you need to free up
disk space.



The -u Option

The -u option enables you to select files that are currently residing in a Zip file and specify which of those
files you wish to update to the latest version



The -f Option

The Freshen option is limited to working with files that

ALREADY exist in the ZIP file. Existing zipped files will be overwritten ONLY if the files have been
updated since being added to the ZIP file. It will NOT add new files.

-f STORE.ZIP **

In the above example, all the existing files in the ZIP file, STORE, will be updated if a newer version of the
file exists in the current directory.



The -d Option

This will allow you to delete selected files from a Zip file. Zip Manager also lets you delete the entire Zip
file.



The -s Option

-s<password> Scramble files with password

This option is used to scramble, or encrypt the files in the ZIP file. It includes password protection. When
extracting the ZIP file, the files will not be extracted unless the correct password is included on the
command line.



